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About Me
• Assistant Professor, Dpt. Of Biostatistics
• Teaching:

– ReMA Quantitative Foundations (Fall, MPH Core)
– Analysis of Categorical Data (Spring)
– Grant Writing (Summer, CSRI)

• Research:  Application of statistics to mental health, 
psychiatry, and health policy.
– Diagnosis and Treatment of Complicated Grief 
– Impact of Medical Marijuana Laws on drug use
– Impact of the Affordable Care Act among those with substance 

use disorders.
– Opioid Center
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Outline
• Motivating Example
• Overview of R and R Studio 
• Importing Data

– Read CSV files using readr package

• Examining Data Attributes
– Data structure, type and dimensionality

• Manipulating Data (Data Wrangling)
– Select, Filter, Mutate, Arrange
– Stacking and Merging
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Application
• A study was conducted to identify risk factors for low infant birth 

weight using data from 189 live births at Bay State Medical Center 
in Massachusetts.  Low birthweight was defined as a <2500grams.

• We have one data set for low birthweight-babies 
(lowbwt_LOW.csv) and another for normal birthweight babies 
(lowbwt_Normal.csv).
– id  = ID number of infant
– smoke = smoking during pregnancy = 1 if yes; 0 if no
– age = mother’s age in years

• We have a separate dataset with data on # of visits 
(lowbwt_ADMIN.csv).
– id  = ID number of infant
– visits = number of physician visits during 1st trimester = 0 if none; 1 if one; 

2 if two or more
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Why R?
• R is a FREE, open-source software used for statistical 

computing and graphics
• Can be frustrating: a steep learning curve

• Installing R: http://cran.r-project.org/ (for Windows, Mac, Linux)

• Some online resources:

https://cran.r-project.org/doc/manuals/r-release/R-intro.pdf

http://www.mayin.org/ajayshah/KB/R/index.html

R.D., Peng Exploratory Data Analysis With R: https://leanpub.com/exdata
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http://cran.r-project.org/
http://www.statmethods.net/about/learningcurve.html
http://www.mayin.org/ajayshah/KB/R/index.html
https://leanpub.com/exdata


6

What is RStudio?
• User-friendly development environment for R

• Installing RStudio: http://www.rstudio.com/

• Some online resources:

http://dss.princeton.edu/training/

http://libguides.princeton.edu/dss
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http://www.rstudio.com/
http://dss.princeton.edu/training/
http://libguides.princeton.edu/dss
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RStudio Windows

7

Console is where you execute the 
commands and see the output

R script contains commands 
/functions to submit to the 
command line

Plots tab displays the graphs

History tab keeps a record of all 
previous commands

Environment contains created 
objects
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R Workflow
• For every new project, do the following:

– Create a directory with a reasonable name and path (e.g. 
~/Documents/RCourse_Part1/)

• Put an R Project in the directory
– Create an R Project using File > New Project > Existing 

Directory and specifying the directory you just created.

• Keep everything related to the analysis – datasets, 
scripts, reports, output – in there!
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Let’s try it!
• Create a directory with a reasonable name and path 

(e.g. ~/Documents/RCourse_Part1/)
• Create an R Project using File > New Project > 

Existing Directory and specifying the directory you 
just created.

• Move the three datasets for this assignment to that 
directory!
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RStudio - Essentials
• How to create and save an R script

• Type R commands and run them 
– Note that you can execute commands (e.g. the line with 

the cursor or highlighted code) in the console from a 
script using Command+Enter (Mac) or Ctrl+Enter
(Windows).
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R Packages
• Packages are collections of R functions, data, and 

compiled code in a well-defined format. 
• The directory where packages are stored is called 

the library. 
• R comes with a standard set of packages. Others are 

available for download and installation. 
– Only need to install package one time.

• Once installed, they have to be loaded into the 
session to be used.
– Once installed, you need to load package every time you 

use R!
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Let’s try it: Packages
• Start a new R script. Save the script so you have the 

code for later.
• Type a comment at the beginning of your program.
• Install and Load dplyr package:

– install.packages(c(“dplyr”))
• This installs dplyr if you haven’t used it before
• Type y in console to any questions about installing dependencies!

– library(dplyr)
• This loads the dplyr library – repeat every time you open R!
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Let’s try it: Packages
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Why dplyr?
• Most of what we are going to learn today can be 

done in base R using other code.
• We are using dplyr which is a part of the tidyverse.
• Why the tidyverse?

– The tidyverse is a coherent system of packages for data 
manipulation, exploration and visualization that share a 
common design philosophy. 

– mostly developed by Hadley Wickham. 
– Tidyverse packages are intended to make statisticians and 

data scientists more productive by guiding them through 
workflows that facilitate communication, and result in 
reproducible work products.
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R Help
• Use tab ‘Help’ to look for a 

topic

E.g., look for function ‘plot’

• Tab ‘Help’ has a history of 
the most recent topics you 
inquired about

• Or just type help(plot) in 
the console
– Or ?plot
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R Syntax
• R is an object-oriented programming language

– If you want to save results, need to store them in an object.

• R is case sensitive: ‘A’ and ‘a’ are different symbols

• Commands are separated either by (;) or by a new line

– Commands can be grouped together (in functions) by { and }

• Comments can be inserted almost anywhere 

– Starting with a ‘#’, everything to the end of the line is a 
comment

– Use comments to document your code: for YOU and 
OTHERS!!
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R Errors
• Syntax errors - generated by misspelling or forgetting 

to close a bracket

• Semantic errors – correct code, but the outcome is 
NOT what you expected

• Logic errors – worst case! The mistake is not in the 
code, but the logic of execution
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IMPORTING DATA
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Reading Data into R
• First, you need to save your data onto your computer

– Excel, SPSS, or some other type of file
– Datasets need to be in the “PROJECT” folder we created 

earlier

• Some useful tips:
– Reserve the first row for headers (variable/column names)
– First column is used to identify sampling units
– Avoid named or fields with blank spaces; put a ‘_’ instead.
– Delete comments from Excel 
– Missing values should be noted with ‘ . ‘ or ‘NA’
– Avoid symbols such as:  ‘ #,  ?,  *,  <,  /, -, }’
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Reading Data into R
• Read CSV files – if you have a ‘.csv’ file (comma 

separated file)
read_csv(“./Data.csv”) You need to load the readr package first!
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DATA ATTRIBUTES
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Data Description
Before running any analysis, make sure you examine your 
data!!!

Number of variables and their types, number of observations, dates 
of creation, etc.

• Check variable names
R: names(mydata)

• Check data dimensions: (#rows) by (# columns)
• Look at the ‘top’ and ‘bottom’ of the data

R: head(mydata), tail(mydata)

• Check “structure”
R: str(mydata)

• Check for missing data
R: anyNA(mydata)
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Let’s try it!



24

Data Description: Examples
• Tabulate your data 

R function: table(mydata)
• Symbol ‘$’ is used to select a specific column from your 

dataset
Example: tabulate variable ‘smoke’ from data ‘low_birth’

• In data ‘low_birth’ there are 30 subjects identified as 
‘smokers’ and 29 subjects that are ‘non-smokers’.
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DATA MANIPULATION
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Operators in R
Logical comparisons

< for less than
> for greater than
<= for less than or equal to
>= for greater than or equal to
== for equal to each other
!= not equal to each other
is.na()  is NA
!is.na() is not NA.

Logical operators
value == 2|3; value equal 2 or (|) 3
&; means and. For example smoke == “0” & age > 25
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Data Transformations: R Math
>log() – natural logarithm

>sqrt() – square root

>x^n – exponent

Matrix Operations:
>A%*%B  - matrix multiplication

>t(A) – matrix transpose

>det(A) – determinant of A

>diag(A) – diagonal of A

>solve(A) – matrix inverse 27
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Data Manipulation (or Wrangling)
• From this point forward we will use 

library(dplyr) for data selection and 
manipulation

• Main Functions for data manipulation in dplyr:
1. Select
2. Filter
3. Mutate
4. Arrange
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Select
• From this point forward we will use library(dplyr) for 

data selection and manipulation
• Select only certain columns (or variables in a dataset)

R function: select(mydata, col_name)
Examples:
• select only one column
• select several columns
• select all columns but one
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Let’s try it: SELECT
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Renaming Variables
• Renaming a variable in a dataset can be done with:

R function: rename(mydata, new_name_var = old_name_var)

Example: Rename variable ‘smoke’ to ‘smoking_status’
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Filter
• Filter

– Some data tables will include rows you don’t need for your 
current analysis.

– You should filter rows based on logical expressions using 
the filter function.

– You will often filter using comparison operators (>, >=, <, 
<=, ==, and !=).

• Example: Suppose we only want to include mothers 
under 20 years of age.
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Let’s try it: FILTER
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More examples: FILTER
• What if we want moms < 20 and non-smokers??

– filter(lowbwt_data, age < 20 & smoke==0)
– filter(lowbwt_data, age < 20, smoke==0)

• What if we want moms < 20 OR non-smokers
– filter(lowbwt_data, age < 20 | smoke==0)
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MUTATE
• Sometimes you need to change columns or create 

new ones. 
– You can do this using mutate.
– NOTE: columns = variables in your data set; rows = 

observations in data set

• Example: apply a log transformation to skewed 
variables
R function: mutate(mydata, new_name_var = transform_old_var)
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Let’s try it: Mutate
• Sometimes you want to create new variables derived 

from existing ones
– E.g., apply a log transformation to skewed variables
R function: mutate(mydata, new_name_var = transform_old_var)

Example: 
Let’s take the 
log of ‘age’
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Mutate Example 2
• What if we wanted to create a new binary variable 

to indicate age < 20? 
• Need if_else function. General syntax:

– if_else (condition, value if true, value if false)

• Let’s try it!

Missing 
Data??
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ARRANGE
• Order rows of a data 

according to one of the 
variables 
R function: arrange(mydata, 
ordering_variable)

Example: order data by ‘id’

• Use function desc() to arrange 
in descending order

• See R code for ordering by 
multiple variables/columns
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COMBINING DATASETS
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Combining Datasets (Stacking)
• Combine datasets that have the same variables but 

different observations
• Combine by Rows:

data 1
ID
1
4
6

data 2
ID

2
5

7

combined
ID

1

4

6

2
5

7
Missing 

Variables?
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Combine by Rows
• General Syntax: 

– combined_data = bind_rows(data1, data2, data3, …)

• Before stacking datasets, it’s helpful to create a 
variable to identify which data source they are 
coming from!
– mutate(data1, variable=1)
– mutate(data2, variable=2)
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Let’s try it: Stacking Datasets
• Right now we only have data on low birthweights; 

suppose we want to combine that with data on 
normal birthweights. 
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Result
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Merging Datasets
• Useful when you need to combine data from different 

sources, or at different times

• Merging two datasets require that both have at least one variable in 
common (either character or numeric). 
– If character, make sure the categories have the same spelling (i.e. country names, 

etc.). 

data 1
ID Age
1 15
2 20
3 18

data 2
ID Age Weight

1 15 115
2 20 134

6 22 140

combined
ID Age Weight

1 15 115

2 20 134
3 18 .

6 22 140
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Merging Datasets in R

Inner: keeps data that appear in both x and y
Left: keeps data that appear in x
Right: keeps data that appear in y
Full: keeps data that appear in either x or y

Missing 
Data??
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*_join in R
• General Syntax

– newdata = inner_join(data1, data2, by = “ID”)
– newdata = left_join(data1, data2, by = “ID”)
– newdata = right_join(data1, data2, by = “ID”)
– newdata = full_join(data1, data2, by = “ID”)
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Let’s try it: Merging datasets
• Suppose we’d like to bring in information on # of visits during the first 

trimester from another administrative data source.
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Results and write_csv
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Next Steps
• We now have one data set that includes data on low 

and normal birthweight babies and includes data on 
# of visits!

• Next time, we will explore this data.
– Descriptive Statistics
– Visualizing Data
– Basic Hypothesis Testing
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Thank you!

Visit our BERD EDU website for additional resources:
http://irvinginstitute.columbia.edu/resources/biostat_educational_initiatives.html

Data Wrangling Cheat Sheet on Dropbox !

Acknowledgements: Jeff Goldsmith (Data Science 1 notes: 
http://p8105.com/)  

http://irvinginstitute.columbia.edu/resources/biostat_educational_initiatives.html
http://p8105.com/

